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ADRSA Training, GIS lll: ArcMap Advanced

Introduction

Work through hands-on exercises using ArcGIS modules Catalog, Map and Toolbox.
Continue learning about data manipulation, selection and analysis tools. Create and edit
your own data through digitizing features and adding tabular information. Practice linking
external data and identifying and downloading data from the internet.

Objectives
* Export data (copy layers) * Digitize new features
* Build queries (equations) to select * Add information (attributes) about
features in a table features to a table
* Build queries to select/ show features * Calculate field values
in the view

* Create new shapefile in Catalog

* Edit .dbf files for import to ArcMap

* Bring XY coordinate data (tabular) into

* Specify a projection in Catalog for a ArcMap

new layer

* Create a graph and add to layout

e Add new fields/columns to a table

Prerequisites

GIS I: ArcMap Introduction and GIS 1l: ArcMap Intermediate, or "equivalent skills."

Related Training Available

All workshops offered through Information Services are free to KU students, staff, faculty, and
approved affiliates. To learn more about or register for workshops, receive automatic

announcements of upcoming workshops, and track workshops you registered for and attended,
visit the KU Libraries Instruction Web site at www.lib.ku.edu/instruction. You can also check our
online schedule at www.ku.edu/acs/schedule for a list of class offerings and availability. For
further workshop related questions, please email training@ku.edu.

Definitions

Term

Definition

attribute table

spreadsheet-like organization of raster or vector tabular data in
rows and columns.

dbase (dbf)

database file format (*.dbf), the file format produced by Dbase, a
commercial relational database system; .dbf files comprise the
tabular data file in GIS shapefiles and can be imported as tables
into ArcGIS.

decimal degrees

latitude and longitude measurements expressed in decimal
format; requires conversion from degrees, minutes, seconds to
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decimal degrees; 1 degree = 60 minutes and 1 minute = 60
seconds; also decimal degrees are the units for unprojected data
or data in the ‘Geographic’ projection.

digitize create digital data layers based on existing digital data or from
hard copy information; heads-up digitizing involves creating
features on the computer screen using some source of reference
data; tablet digitizing involves using a digitizing tablet/ board
connected to a computer, and is often used to convert paper map
features to digital format; user traces over features of interest and
X,y coordinates are recorded and stored as spatial data (ESRI).

field a column in the attribute table of a raster or vector data file.

geodatabase relational database that contains geographic information such as
feature classes and tables; feature classes can be organized into
feature datasets or exist independently; feature classes store
geographic features represented as points, lines, or polygons,
and their attributes; many objects in a geodatabase can be
related to each other (www.esri.com).

latitude-longitude spherical reference system used to measure locations on Earth's
surface; latitude is measured from the equator, with positive
values going north and negative values south; longitude is
measured from the Prime Meridian (the longitude that runs
through Greenwich, England), with positive values going east
and negative values west ( nasa.gov and esri.com).

map scale dimensions of a map compared to the dimensions of the Earth,
usually expressed as a ratio between a distance on the map and
a distance on the Earth; a scale of 1:24,000 indicates that one
unit of distance on the map equals 24,000 units on the ground.

merge function of ArcMap that combines multiple features
(records/polygons); attributes of final merged feature are based
on one of the input features; separate data layers can also be
merged in geoprocessing.

record a row in the attribute table of a raster or vector data file,
represents one feature.

Copy Workshop Data

* To copy workshop data from network drive to hard drive, click on Start (button) = Programs
- ArcGIS - Data

* Click once on the folder called gis2_3
* Under File and Folder Tasks, choose ‘Copy this folder’

* Make sure c:\ wutemp is selected as file destination
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Click on ‘Copy’

Explore ArcMap

Start ArcMap: Start menu - All Programs - ArcGIS - ArcMap

Maximize the application (click on 18] middle button, top right corner)

Add Data

. + . .
Click on the ‘Add Data’ button ‘ ' to bring data layers into ArcMap
Navigate to: c:\ wutemp\ gis2_3

To add the following vector layers ALL at once, hold down the control (Ctrl) key and click on
(highlight) each layer:

CITIES.shp (major cities)

POLBNDA.shp (political boundaries)

WWZF_ECO (ecological data from World Wildlife Federation)
Click on ‘Add’
Turn on all layers (if not already)

Change the cities layer properties so capital cities appear as stars (Symbology tab,
Categories - Unique Values, set ‘Field Value’ to ‘CAPITAL’, click on ‘Add All Values'...)

Change the WWF_ECO layer properties to display by habitat type (Symbology tab,
Categories = Unique Values, set ‘Field Value’ to ‘MHT_NAME’, click on ‘Add All Values'...);
MHT = Major Habitat Code

Open the boundary layer attribute table (right-click on layer name)

How many records are in the table?

Make a copy of boundaries for ONLY South American countries

Close table and double-click on boundary layer

Click on the ‘Definition Query’ tab and then on the ‘Query Builder’ button to build an
equation that selects and displays only South American countries (in both view and table)

Double-click on field name (NA3_DESCRI) and Single-click on operator (=)
Click ‘Get Unique Values’ button to display all possible field values
Double-click on field value (South America) to complete the equation:
"NA3_DESCRI" ='South America'

Click OK and OK again

Right-click on country layer title and choose Data 2 Export Data
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* Export all features using the same coordinate system as the layer’'s source data and save
in c:\wutemp as c2.shp

* Choose Yes to add the new layer
* Right-click to remove the original boundary layer (POLBNDA)

* Change the symbology of the new country boundaries in layer properties (right-click on layer
name, choose ‘Properties’) so the layer is completely transparent except for boundary lines
(Display tab)

* Openthe new countries layer attribute table (right-click on layer name)

How many records are in the table?

Save Data/View Settings as One File

* Choose File > Save As and save your work as a map document in c:\wutemp

* As you work, choose File & Save to save your changes

Highlight a country
We have multiple records/ polygons for many countries, and Want onIy one feature for each.
* Inthe view, choose Selection = Select by Attributes

* Create a new selection from the (new) countries layer

Select By Attributes

) ) i & Query Wizard...
e Double-click on field name (NA2_DESCRI) and Single-  f .. 2 =
C||Ck on Opel’atol’ (:) L I Only show selectable layers in this list
. . . Method:  |Create a new selection ~|
* Click ‘Get Unique Values’ to see all possible values Fieds Unique Valies
(e = o] el oo
e Double-click on field value (Chile) to complete the q [ > | o= | v [Botis
equation: "NA2_DESCRI" ="'Chile' el | I ] o
. . s . , :'NA3_DESCRI:: _|% 0 Not (’ v s
* Click on ‘Apply’ and ‘Close IFEPATHLN j'—‘ Gore [——
« Choose Selection - Zoom to Selection | | =

* Zoom in close enough to see the numerous tiny polygons  |q SELEcT *FRoM c2wHerE:
used to represent land areas for countries such as Chile, DESrT= e
and at the northern and southern tips of the continent

* Open the c2 layer attribute table (right-click on layer

name)
* Sort the field for country name (NA2_DESCRI) in Gesr | veiy | Hep | Losd. | swe. |
ascending order; right-click on field heading Aoy Closo

Merge records for the same country into one
* Make Editor toolbar visible: Choose View = Toolbars = Editor

* On Editor toolbar, choose Start Editing
* Inthe ‘Start Editing’ window, select the folder location of c2 if given this option
* Choose this layer to edit and click Start Editing

* Specify ‘Task’ (Create New Feature) and 'Target’ (c2) on the menu
* Click on the ‘Selected’ button at bottom of the attribute table to show highlighted records
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* To merge the selected polygons (Chile records), click on the Editor menu and choose
Merge...
* Inthe Merge window, click OK to take the first record as the one to ‘merge to’

All other records will be merged into this one; the new record will have these same values for all
fields such as area, f_code, etc.

Remember ArcView has the ‘Undo’ function : ‘ > ' on the menu.

* Repeat this process (steps listed below) for the following countries represented by many
features, so that each country is represented by one record in the table: Argentina, Brazil,
Columbia, Falkland Islands..., Venezuela

* If the merge process stalls or crashes the program or machine, restart ArcMap, open your
MXD file, and try merging 5 or fewer records at a time.

Merge Process

* In the attribute table, click on the ‘All’ button to show all other records
* Click on ‘Options’ button, then Select by Attributes
e Use the ‘Create a new selection’ method

* Double-click on field name, Single-click on operator, Double-click on field value and build
the equation: "NA2_DESCRI" ="'country name'

* Click on ‘Apply’ and ‘Close’

* Inthe view, choose Selection 2 Zoom to Selected Features to see the polygons that will
share one record (or row)

* Inthe table, click on the ‘Selected’ button at the bottom to show only highlighted records

* To merge the selected polygons, click on the Editor menu and choose Merge...

* When finished merging for these six countries, choose Stop Editing on Editor toolbar and
Yes to SAVE your changes

Some countries now have ‘multipart’ features or one record/country that represented by

multiple polygons.

Format tabular data in Excel | Fe Edt Yew Isert Fomet To
O

DeRa SRY|4E

We will use data loaded on hard drive as a .dbf file (ArcGIS

. . . ial
reads this format). The table contains temperature in degrees | =
Celsius by month and XY coordinates (latitude/ longitude) for IJ @9 Snaglt (S | window
locations of data collection. However, columns are not wide Al = = LON

enough for all cell values to be seen (ArcGIS will not recognize

LON LAT LONG LATI ELE
unless all values are readable). |

820 300 -8175 3025 !
825 300 -8225 3025 2
830 300 8275 3025 3
835 3008325 3025 3
. . . , -840 300 -8375 3025 1
* Navigate to c:\wutemp\gis2_3 and double-click on the file QAL AN G498 AnoE A

called TMP.DBF (if prompted choose to open the file in Excel)

* Right-click on the Start button and choose ‘Explore’ to open
Windows Explorer

|| &= W

* To highlight and format ALL columns at once in the table, click on the gray box in the
upper left corner of the spreadsheet (click above the first cell and left of the ‘A’ column)
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* Choose Format menu = Column - Autofit Selection so all columns are automatically
widened to show all cell values

* Choose File menu > Save As and save your file in c:\wutemp as temp.dbf (Save in .dbf IV
format)

* Say Yes to message that appears about saving in .dbf format

e Close Excel

Bring XY data into ArcMap as a spatial layer

Latitude and longitude are used to measure locations on Earth's surface.

Y Longitude lines, or meridians of longitude correspond to the ‘X’ dimension
and measure east/ west. Latitude lines, or parallels of latitude correspond to
the 'Y’ dimension and measure north/ south. Latitude and longitude are
measured in degrees, minutes and seconds.

1 degree = 60 minutes and 1 minute = 60 seconds

ArcMap requires coordinates in decimal degree format, or degrees/ minutes/ seconds
expressed as decimals. Thus 65° 45’ 36” south latitude converts to -65.76 degrees latitude:

-(65 degrees +
(45 minutes * (1 degree/60 minutes)) +

(36 seconds * (1 minute/60 seconds) * (1 degree/60 minutes)))

* In ArcMap, choose Tools - Add XY Data

* Click on the yellow folder and navigate to your temp.dbf file (c:\\wutemp); select the file and
click on ‘Add’

* Make sure the dropdown field for ‘X’ or longitude is set to LON (the field in the temp.dbf file
that contains longitude values)

* Make sure the field for ‘Y’ or latitude is set to LAT (the field in temp.dbf for latitude) and click
OK

* You should now see a file in the table of contents called temp Events

e Zoom in close enough to discern separate points

* Use the ‘Identify’ tool [6 (click on tool then on a map feature) to get temperature
information from the attribute table for various locations (points)

* Open the attribute to see the table you imported; this ‘Event’ layer is a temporary display in
ArcMap based on latitude/longitude

* To save the file as a permanent layer (close table), right-click on layer name and choose
Data - Export Data

* Export all features using the same coordinate system as the layer's source data and save
in c:\\wutemp as temps.shp

* Click OK

* Choose Yes to add your new shapefile
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Remove original .dbf table (right-click on event layer)

Zoom out to see the entire layer

Create new field for average annual temperature

Open the attribute table of the temps shapefile

Click on ‘Options’ and ‘Add Field’ to add a new blank field

Assign a name (average) and type (floating) to the field; floating = decimal
Click OK

Right-click on the new field heading and choose ‘Calculate Values...’ (choose Yes to the
warning message)

Set the ‘average’ field equal to the average of the twelve months of temperature data (be
sure to include parenthesis around the addition part):

([APR]+[AUG]+[DEC]+[FEB]+[JAN]+[JUL]+[JUN]+[MAR]+[MAY]+[NOV]+[OCT]+[SEP]) / 12

Click OK

Change ‘Layer Properties’ to display the temperature layer by average annual temperature
(Symbology tab, Quantities - Graduated Colors, set ‘Field Value’ to ‘average’)

Display temperature data using 7 to 10 classes
Click OK

Digitize one or more country boundaries

Create a new layer by tracing over old layer and

Cleanmg up pOIygonS ,:'Arctatalog - ArcYiew - C:4

Choose Tools = ArcCatalog Fie Edt View Go Tooks Help
Navigate to c:\wutemp Folder
Choose File > New - Shapefile [ &9 Connect Folder... Personal Geod!
Type in a name for your new file such as countries3 [ Discornect Folder Layer...
Choose Polygon as feature type | % Delete izt oy
Click on the ‘Edit’ button to define a projection r Rename

i : A ) dBASE Table
(coordinate system) for the new shapefile Properties. .. _

o . =) 5

Choose ‘Import’ to use projection information from & Erift,.. J 0
an_other layer (set projection of new layer to match Exit 0
existing one) T UreuseEssunuTere 7 af 18275 @

Navigate to c:\wutemp and select CITIES.shp

Click ‘Add’

Click ‘OK’ and ‘OK’ again

Select new file and hold and drag to ArcMap (from ‘Windows Explorer style’ list)

Close ArcCatalog
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* In ArcMap, make sure new empty shapefile is at the top of table of contents

* Check ‘Layer Properties’ on the ‘Source’ tab to ensure projection information was written

into the file

* Turn off ALL layers except for country boundaries and new shapefile

* On Editor toolbar, choose ‘Start editing’

* Inthe ‘Start Editing’ window, select the folder location of
counties3 and click OK

* Choose your new countries file and click Start Editing

* Specify ‘Task’ (Create New Feature) and 'Target’ (counties3)
on the menu

2~

* Click on Edit (pencil) tool

e Use ‘Zoom In’ tool @ to zoom the view in to the desired level
while digitizing

* Click on map (and hold) to start digitizing

* Click once to create vertices

* Double-click (near first point) to close and finish a polygon

To delete a point while you digitize:

% _gis2.mxd - ArcMap - ArcYiew

File Edit View Insert Selection Tools Windc

JEditoL' ‘ | # ~ | Task: [create ey
| EECETE 5 5,
T Stop Editing ;
J e @ X | ¢
| i [ (s 10
= F=
a
ut_3
Yriior) KLAND
Inter
clip,,
strial
=reropaTTe
[ Grassland L—
[C]Other ;l
Display | Source B[

* Hold the mouse over the point to delete, right-click and choose ‘Delete Vertex’

If you digitize off the map and need to move it:
* Move mouse to click on pan, zoom, or other navigational tool

* Click on the edit (pencil) tool to resume digitizing

To digitize a shape with a free-flowing drawing motion:
* Right-click in data frame and choose ‘Streaming’
e Start digitizing

* Right-click again and choose ‘Streaming’ (uncheck) to turn off

Remember ArcView includes the ‘Undo’ function (backwards arrow on toolbar)!

* Choose Editor > Save Edits as you work to save your changes

* After you digitize boundaries for one or more countries, choose Editor - Stop Editing and

choose Yes to save changes
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Add blank fields to table

Make sure the attribute table is open and you are not in edit mode and click on ‘Options’
and ‘Add Field’ to add a new blank field (column)

Assign a name (country) and type (text) to the field
Click OK

Add another field for the capital of each country or countries that you digitized
(name=capital, type=text)

Add field values

Use one layer to extract data from ] 2l meur =l

Identify the capital city associated with each country (use Identify tool or other methods)

To add field values (country/city names) in this column, choose Start Editing again on
Editor toolbar

In the ‘Start Editing’ window, select the folder location of new file

Open the attribute table of your new layer (right-click on layer)

In the table, place your cursor in a cell and type in the country or city name for each polygon
Close the table

On the Editor toolbar choose Editor 2 Stop Editing and choose Yes to save changes

AT =

another layer

Geoprocessing allows you to use one |
vector layer as a ‘cookie-cutter’ ]
against another. Make a new
temperature data layer that includes | — | CLIP FEATURE
only data for your country (or
countries)

» Input Features

%

» Clip Features

|

» Output Feature Class

%

Click on the ArcToolbox button e’

S \ 4
OuUTPUT

to access geoprocessing
functions i .

1]'9 | Cancel Environments... << Hide Help I

| =
Expand Analysis Tools, then P
Extract (click on plus sign), and double-click on Clip

Designate temps.shp as input features
Designate your new digitized shapefile as cookie-cutter layer (clip features)

Save to c:\wutemp as mytemps.shp (output feature class) and click OK

Relate ecological characteristics to temperature

Right-click on the mytemps.shp and choose ‘Joins and Relates = Join’

Choose ‘Join data from another layer based on spatial location’ to see what eco-regions
occur at different temperatures/locations
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On Step 1. choose WWF_ECO as the layer to join to temperature data
On Step 2. choose “...it falls inside...’

Save to c:\wutemp as temp_eco.shp

Click OK

Add the new layer

Find the additional data in the attribute table

Create a graph

Add the Quakes layer to your map document

Open the Attribute table for the Quakes layer; ¢

Click on the Options button, then ‘Select by Attributes’

Construct this equation: (Select from Quakes Where):
“Year”=1976 OR “Year”=1986 OR “Year”=1996

Click Apply button and close Attribute table

In the Tools menu, choose Graphs 2 Create
Click on icon for Graph Type Bubble, then click the Next button
In the ‘Choose Layer’ box choose Quakes
Select “Use selected set of features or records” and set:
Bubble size field--- MAG
X Axis MO
Y Axis ---  YEAR
Click Next button
Deselect “Show Legend” and select “Show graph on layout”

Click the Advanced Options button 1o x|

Click the Axis tab

Y Primary is selected: click on User Graph of QUAKES

Defined (in the Scale section) 20001 -

In the Range section, set Max=2000 .”...LJ..CO.

and Min=1970

Click Apply Now button -

Select X (in order to work on the X \>..O...O.(>..

axis)

Select User Defined and set Max=12 : N
) ] )

Select Use (Yo, (0. L oo ] 00

Click Apply Now 1970 4

Click on the Background tab

Graph title is selected; in Graph Window (section) choose a light background color, then
click Apply Now

Click OK and click Finish

Add Quakes table (data) to layout

Turn off layers in the view

Open the attribute table of Quakes layer and ensure same records are selected
Click on the ‘Selected’ button at bottom to show only highlighted records

Click on the Options button and choose ‘Add Table to Layout’
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* Choose View - Layout View and make a layout showing your graph and the data used to
build it

Bring in external population data

* Right-click on the c2 layer (copy) and choose ‘Joins and Relates = Join’

* Choose ‘Join attributes from a table’ to add external (non-spatial) data to the table
= On Step 1. choose NA2_DESCRI as the join field

= On Step 2. navigate to: c:\ wutemp\ gis2_3\isi_data_geodatabase

= Select the tabular file called: pop (unemployment) and click on Add

= On Step 3. choose Country as the join field and click OK

= Right-click on the c2 layer and choose ‘Open Attribute Table’ to see additional data

= Label this layer based on population

Note: Please complete a workshop evaluation. An online evaluation
is linked from the internet browser ‘Favorites’ menu.

For More Information

e Source of GIS data: Global GIS database: Digital Atlas of Central and South America
(library CD), Call No. | 19.121:62-A, can be checked out.

* Download extensions (add specialized functions): http://arcscripts.esri.com

Getting Additional Help

Online Tutorials- Learn GIS at your own pace through virtual tutorials. ESRI online tutorials are
available free to KU-affiliates and can be used by individuals or classes. See a list of courses at
www.kars.ku.edu/user/vc_courses.shtml and email or call (data@ku.edu, mickey@ku.edu or
864-1238, 864-0454) to register for one or more.

GIS and Data Lab - 105 Anschutz Library

Hours (while KU is in session): Mon-Thurs 9AM-8PM, Fri 9AM-5PM, Sat/Sun 1PM-5PM
Contact: data@ku.edu or 864-1238 (Rhonda Houser), 864-7777 (Mickey Waxman)

More information at www.lib.ku.edu/gis Last Update: 03/15/20066
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